PCLIB User's Guide

DSP56800E

Document Number: DSP56800EPCLIBUG
Rev. 2, 10/2015
## Contents

<table>
<thead>
<tr>
<th>Section number</th>
<th>Title</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td><strong>Chapter 1</strong></td>
<td></td>
</tr>
<tr>
<td>1.1</td>
<td>Introduction</td>
<td>5</td>
</tr>
<tr>
<td>1.2</td>
<td>Library integration into project (CodeWarrior™ Development Studio)</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td><strong>Chapter 2</strong></td>
<td></td>
</tr>
<tr>
<td>2.1</td>
<td>PCLIB_Ctrl2P2Z</td>
<td>17</td>
</tr>
<tr>
<td>2.2</td>
<td>PCLIB_Ctrl3P3Z</td>
<td>19</td>
</tr>
<tr>
<td>2.3</td>
<td>PCLIB_CtrlPI</td>
<td>22</td>
</tr>
<tr>
<td>2.4</td>
<td>PCLIB_CtrlPIandLPFilter</td>
<td>25</td>
</tr>
<tr>
<td>2.5</td>
<td>PCLIB_CtrlPID</td>
<td>28</td>
</tr>
</tbody>
</table>

Chapter 1
Library

1.1 Introduction

1.1.1 Overview

This user's guide describes the Power Control Library (PCLIB) for the family of DSP56800E core-based digital signal controllers. This library contains optimized functions.

1.1.2 Data types

PCLIB supports several data types: (un)signed integer, fractional, and accumulator. The integer data types are useful for general-purpose computation; they are familiar to the MPU and MCU programmers. The fractional data types enable powerful numeric and digital-signal-processing algorithms to be implemented. The accumulator data type is a combination of both; that means it has the integer and fractional portions.

The following list shows the integer types defined in the libraries:

- **Unsigned 16-bit integer** —\(<0 ; 65535>\) with the minimum resolution of 1
- **Signed 16-bit integer** —\(<-32768 ; 32767>\) with the minimum resolution of 1
- **Unsigned 32-bit integer** —\(<0 ; 4294967295>\) with the minimum resolution of 1
- **Signed 32-bit integer** —\(<-2147483648 ; 2147483647>\) with the minimum resolution of 1

The following list shows the fractional types defined in the libraries:

- **Fixed-point 16-bit fractional** —\(<-1 ; 1 - 2^{-15}>\) with the minimum resolution of \(2^{-15}\)
- **Fixed-point 32-bit fractional** —\(<-1 ; 1 - 2^{-31}>\) with the minimum resolution of \(2^{-31}\)
The following list shows the accumulator types defined in the libraries:

- **Fixed-point 16-bit accumulator** $\langle -256.0 ; 256.0 - 2^{-7} \rangle$ with the minimum resolution of $2^{-7}$
- **Fixed-point 32-bit accumulator** $\langle -65536.0 ; 65536.0 - 2^{-15} \rangle$ with the minimum resolution of $2^{-15}$

### 1.1.3 API definition

PCLIB uses the types mentioned in the previous section. To enable simple usage of the algorithms, their names use set prefixes and postfixes to distinguish the functions' versions. See the following example:

```c
f32Result = MLIB_Mac_F32lss(f32Accum, f16Mult1, f16Mult2);
```

where the function is compiled from four parts:

- **MLIB**—this is the library prefix
- **Mac**—the function name—Multiply-Accumulate
- **F32**—the function output type
- **lss**—the types of the function inputs; if all the inputs have the same type as the output, the inputs are not marked

The input and output types are described in the following table:

<table>
<thead>
<tr>
<th>Type</th>
<th>Output</th>
<th>Input</th>
</tr>
</thead>
<tbody>
<tr>
<td>frac16_t</td>
<td>F16</td>
<td>s</td>
</tr>
<tr>
<td>frac32_t</td>
<td>F32</td>
<td>l</td>
</tr>
<tr>
<td>acc32_t</td>
<td>A32</td>
<td>a</td>
</tr>
</tbody>
</table>

### 1.1.4 Supported compilers

PCLIB for the DSP56800E core is written in assembly language with C-callable interface. The library is built and tested using the following compilers:

- CodeWarrior™ Development Studio

For the CodeWarrior™ Development Studio, the library is delivered in the `pplib.lib` file.
The interfaces to the algorithms included in this library are combined into a single public
interface include file, pclib.h. This is done to lower the number of files required to be
included in your application.

1.1.5 Special issues

1. The equations describing the algorithms are symbolic. If there is positive 1, the
number is the closest number to 1 that the resolution of the used fractional type
allows. If there are maximum or minimum values mentioned, check the range
allowed by the type of the particular function version.

2. The library functions require the core saturation mode to be turned off, otherwise the
results can be incorrect. Several specific library functions are immune to the setting
of the saturation mode.

3. The library functions round the result (the API contains Rnd) to the nearest (two's
complement rounding) or to the nearest even number (convergent round). The mode
used depends on the core option mode register (OMR) setting. See the core manual
for details.

4. All non-inline functions are implemented without storing any of the volatile registers
(refer to the compiler manual) used by the respective routine. Only the non-volatile
registers (C10, D10, R5) are saved by pushing the registers on the stack. Therefore, if
the particular registers initialized before the library function call are to be used after
the function call, it is necessary to save them manually.

1.2 Library integration into project (CodeWarrior™
Development Studio)

This section provides a step-by-step guide to quickly and easily integrate the PCLIB into
an empty project using CodeWarrior™ Development Studio. This example uses the
MC56F8257 part, and the default installation path (C:\Freescale\FSLESL
\DSP56800E_FSLESL_4.2) is supposed. If you have a different installation path, you
must use that path instead.

1.2.1 New project

To start working on an application, create a new project. If the project already exists and
is open, skip to the next section. Follow the steps given below to create a new project.

2. Choose File > New > Bareboard Project, so that the "New Bareboard Project" dialog appears.
3. Type a name of the project, for example, MyProject01.
4. If you don't use the default location, untick the “Use default location” checkbox, and type the path where you want to create the project folder; for example, C:\CWProjects\MyProject01, and click Next. See Figure 1-1.

![Figure 1-1. Project name and location](image1)

5. Expand the tree by clicking the 56800/E (DSC) and MC56F8257. Select the Application option and click Next. See Figure 1-2.

![Figure 1-2. Processor selection](image2)

6. Now select the connection that will be used to download and debug the application. In this case, select the option P&E USB MultiLink Universal[FX] / USB MultiLink and Freescale USB TAP, and click Next. See Figure 1-3.
7. From the options given, select the Simple Mixed Assembly and C language, and click Finish. See Figure 1-4.

The new project is now visible in the left-hand part of CodeWarrior™ Development Studio. See Figure 1-5.

### 1.2.2 Library path variable

To make the library integration easier, create a variable that will hold the information about the library path.

1. Right-click the MyProject01 node in the left-hand part and click Properties, or select Project > Properties from the menu. The project properties dialog appears.
2. Expand the Resource node and click Linked Resources. See Figure 1-6.

![Properties for MyProject01](image)

**Figure 1-6. Project properties**

3. Click the 'New...' button on the right-hand side.
4. In the dialog that appears (see Figure 1-7), type this variable name into the Name box: FSLESL_LOC
5. Select the library parent folder by clicking 'Folder...' or just typing the following path into the Location box: C:\Freescale\FSLESL\DSP56800E_FSLESL_4.2_CW and click OK.
6. Click OK in the previous dialog.
1.2.3 Library folder addition

To use the library, add it into the CodeWarrior Project tree dialog.

1. Right-click the MyProject01 node in the left-hand part and click New > Folder, or select File > New > Folder from the menu. A dialog appears.
2. Click Advanced to show the advanced options.
3. To link the library source, select the third option—Link to alternate location (Linked Folder).
4. Click Variables…, and select the FSLESL_LOC variable in the dialog that appears, click OK, and/or type the variable name into the box. See Figure 1-8.
5. Click Finish, and you will see the library folder linked in the project. See Figure 1-9.
1.2.4 Library path setup

1. Right-click the MyProject01 node in the left-hand part and click Properties, or select Project > Properties from the menu. A dialog with the project properties appears.
2. Expand the C/C++ Build node, and click Settings.
3. In the right-hand tree, expand the DSC Linker node, and click Input. See Figure 1-11.
4. In the third dialog Additional Libraries, click the 'Add…' icon, and a dialog appears.
5. Look for the FSLESL_LOC variable by clicking Variables…, and then finish the path in the box by adding one of the following:
   • ${FSLESL_LOC}\MLIB\mlib_SD.M.lib—for small data model projects
   • ${FSLESL_LOC}\MLIB\mlib_LDM.lib—for large data model projects
6. Tick the box Relative To, and select FSLESL_LOC next to the box. See Figure 1-9. Click OK.
7. Look for the FSLESL_LOC variable by clicking Variables…, and then finish the path in the box by adding one of the following:
   • ${FSLESL_LOC}\PCLIB\pclib_SD.M.lib—for small data model projects
   • ${FSLESL_LOC}\PCLIB\pclib_LDM.lib—for large data model projects
8. Now, you will see the added in the box. See Figure 1-11.

Figure 1-10. Library file inclusion
9. In the tree under the DSC Compiler node, click Access Paths.
10. In the Search User Paths dialog (#include “…”), click the 'Add…' icon, and a dialog will appear.
11. Look for the FSLESL_LOC variable by clicking Variables…, and then finish the path in the box to be: \${FSLESL_LOC}\MLIB\include.
12. Tick the box Relative To, and select FSLESL_LOC next to the box. See Figure 1-12. Click OK.
13. Look for the FSLESL_LOC variable by clicking Variables…, and then finish the path in the box to be: \${FSLESL_LOC}\PCLIB\include.
14. Now you will see the added in the box. See Figure 1-13. Click OK.
The final step is typing the #include syntax into the code. Include the library into the main.c file. In the left-hand dialog, open the Sources folder of the project, and double-click the main.c file. After the main.c file opens up, include the following lines into the #include section:

```
#include "mlib.h"
#include "pclib.h"
```

When you click the Build icon (hammer), the project will be compiled without errors.
Chapter 2
Algorithms in detail

2.1 PCLIB_Ctrl2P2Z

The PCLIB_Ctrl2P2Z function calculates the compensation block for the controller, which consists of two poles and two zeroes. The s-domain transfer function equation for two-pole two-zero control law is as follows:

\[
\frac{y(s)}{x(s)} = \frac{(s-Z1)(s-Z2)}{(s-P1)(s-P2)}
\]

Equation 1.

where \(y(s)\) is the output, and \(x(s)\) is the input to the system. This control law has two poles (P1 and P2) and two zeroes (Z1 and Z2). The value or the placement of these poles and zeroes in the bode plot affects the stability and performance of the control loop and the system. The z-domain controller \(Gc(z)\) at sampling time \(Ts\) is expressed using the Tustin method as follows:

\[
\frac{y(z)}{x(z)} = \frac{(b2z^2 + b1z + b0)}{(1 - a2z^{-2} - a1z^{-1})}
\]

Equation 2.

\[
y[n] - a1 \cdot y[n-1] - a2 \cdot y[n-2] = b0 \cdot x[n] + b1 \cdot x[n-1] + b2 \cdot x[n-2]
\]

Equation 3.

where:

- \(y[n] = y[n]\) is the present output
- \(y[n-1]\) is the previous output
- \(y[n-2]\) is the previous to previous output
- \(x[n] = x[n]\) is the present error
- \(x[n-1]\) is the previous error
- \(x[n-2]\) is the previous to previous error
- \(b0, b1, b2, a1, and a2\) are the control coefficients and functions of Z1, Z2, P1, P2, and sampling time \(Ts\).
$$y[n] = a_2 \cdot y[n-2] + a_1 \cdot y[n-1] + b_2 \cdot x[n-2] + b_1 \cdot x[n-1] + b_0 \cdot x[n]$$

Equation 4.

For a proper use of this function, it is recommended to initialize the function's data by the PCLIB_Ctrl2P2ZInit function, before using the function. This function clears the internal buffers of the 2P2Z controller. You must call this function when you want the 2P2Z controller to be initialized. The init function must not be called together with PCLIB_Ctrl2P2Z, unless a periodic clearing of buffers is required.

### 2.1.1 Available versions

The available versions of the PCLIB_Ctrl2P2ZInit function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCLIB_Ctrl2P2ZInit_F16</td>
<td>frac16_t</td>
<td>PCLIB_CTRL_2P2Z_T_F16 *</td>
<td>void</td>
</tr>
</tbody>
</table>

The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters structure. It clears the internal delay parameter buffers of the controller.

The available versions of the PCLIB_Ctrl2P2Z function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCLIB_Ctrl2P2Z_F16</td>
<td>frac16_t</td>
<td>PCLIB_CTRL_2P2Z_T_F16 *</td>
<td>frac16_t</td>
</tr>
</tbody>
</table>

The error input is a 16-bit fractional value within the range $\langle -1 ; 1 \rangle$. The parameters are pointed to by an input pointer. The function returns a 16-bit fractional value in the range $\langle -1 ; 1 \rangle$.

### 2.1.2 PCLIB_CTRL_2P2Z_T_F16

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16CoeffB0</td>
<td>frac16_t</td>
<td>Control coefficient for the present error. The parameter is a 16-bit fractional value within the range $\langle -1 ; 1 \rangle$. Set by the user.</td>
</tr>
<tr>
<td>f16CoeffB1</td>
<td>frac16_t</td>
<td>Control coefficient for the past error. The parameter is a 16-bit fractional value within the range $\langle -1 ; 1 \rangle$. Set by the user.</td>
</tr>
<tr>
<td>f16CoeffB2</td>
<td>frac16_t</td>
<td>Control coefficient for the past to past error. The parameter is a 16-bit fractional value within the range $\langle -1 ; 1 \rangle$. Set by the user.</td>
</tr>
<tr>
<td>f16CoeffA1</td>
<td>frac16_t</td>
<td>Control coefficient for the past result. The parameter is a 16-bit fractional value within the range $\langle -1 ; 1 \rangle$. Set by the user.</td>
</tr>
</tbody>
</table>
### 2.1.3 Declaration

The available PCLIB_Ctrl2P2Z functions have the following declarations:

```c
void PCLIB_Ctrl2P2ZInit_F16(PCLIB_CTRL_2P2Z_T_F16 *psParam)
frac16_t PCLIB_Ctrl2P2Z_F16(frac16_t f16InErr, PCLIB_CTRL_2P2Z_T_F16 *psParam)
```

### 2.1.4 Function use

The use of the PCLIB_Ctrl2P2ZInit_F16 and PCLIB_Ctrl2P2Z functions is shown in the following example:

```c
#include "pclip.h"

static frac16_t f16Result, f16InErr;
static PCLIB_CTRL_2P2Z_T_F16 sParam;

void Isr(void);

void main(void)
{
    f16InErr = FRAC16(-0.4);
    sParam.f16CoeffB0 = FRAC16(0.1);
    sParam.f16CoeffB1 = FRAC16(0.2);
    sParam.f16CoeffB2 = FRAC16(0.15);
    sParam.f16CoeffA1 = FRAC16(0.1);
    sParam.f16CoeffA2 = FRAC16(0.25);

    PCLIB_Ctrl2P2ZInit_F16(&sParam);

    /* Periodical function or interrupt */
    void Isr()
    {
        f16Result = PCLIB_Ctrl2P2Z_F16(f16InErr, &sParam);
    }
}
```

### 2.2 PCLIB_Ctrl3P3Z
The PCLIB_Ctrl3P3Z function calculates the compensation block for the controller, which consists of three poles and three zeroes. The s-domain transfer function equation for the three-pole three-zero control law is as follows:

\[
\frac{y[s]}{x[s]} = \frac{(s-Z1)(s-Z2)(s-Z3)}{(s-P1)(s-P2)(s-P3)}
\]

**Equation 5.**

where \(y[s]\) is the output and \(x[s]\) is the input to the system. This control law has three poles (P1, P2, and P3) and three zeroes (Z1, Z2, and Z3). The value or the placement of these poles and zeroes in the bode plot affects the stability and performance of the control loop and the system. The z-domain controller \(G_c(z)\) at sampling time \(T_s\) is expressed using the Tustin method as follows:

\[
\frac{y[t]}{x[t]} = \frac{(b_3 z^{-3} - b_2 z^{-2} - b_1 z^{-1} - b_0)}{(a_3 z^{-3} - a_2 z^{-2} - a_1 z^{-1} - a_0 z^{-1})}
\]

**Equation 6.**

\[
y[t] - a_1 \cdot y[t] \cdot z^{-1} - a_2 \cdot y[t] \cdot z^{-2} - a_3 \cdot y[t] \cdot z^{-3} = b_0 \cdot x[t] + b_1 \cdot x[t] \cdot z^{-1} + b_2 \cdot x[t] \cdot z^{-2} + b_3 \cdot x[t] \cdot z^{-3}
\]

**Equation 7.**

where:

- \(y[t] = y[n]\) is the present output
- \(y[t] \cdot z^{-1} = y[n-1]\) is the previous output
- \(y[t] \cdot z^{-2} = y[n-2]\) is the previous to previous output
- \(y[t] \cdot z^{-3} = y[n-3]\) is the previous to previous to previous output
- \(x[t] = x[n]\) is the present error
- \(x[t] \cdot z^{-1} = x[n-1]\) is the previous error
- \(x[t] \cdot z^{-2} = x[n-2]\) is the previous to previous error
- \(x[t] \cdot z^{-3} = x[n-3]\) is the previous to previous to previous error
- \(b_0, b_1, b_2, b_3, a_1, a_2, \text{ and } a_3\) are the control coefficients and functions of \(Z1, Z2, Z3, P1, P2, \text{ and } P3\), and sampling time \(T_s\).

\[
y[n] = a_3 \cdot y[n-3] + a_2 \cdot y[n-2] + a_1 \cdot y[n-1] + b_3 \cdot x[n-3] + b_2 \cdot x[n-2] + b_1 \cdot x[n-1] + b_0 \cdot x[n]
\]

**Equation 8.**

For a proper use of this function, it is recommended to initialize the function's data by the PCLIB_Ctrl3P3ZInit function, before using the function. This function clears the internal buffers of the 3P3Z controller. You must call this function when you want the 3P3Z controller to be initialized. The init function must not be called together with PCLIB_Ctrl3P3Z, unless a periodic clearing of buffers is required.
2.2.1 Available versions

The available versions of the PCLIB_Ctrl3P3ZInit function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCLIB_Ctrl3P3ZInit_F16</td>
<td>frac16_t</td>
<td>PCLIB_CTRL_3P3Z_T_F16 *</td>
<td>void</td>
</tr>
</tbody>
</table>

The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters structure. It clears the internal delay parameter buffers of the controller.

The available versions of the PCLIB_Ctrl3P3Z function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCLIB_Ctrl3P3Z_F16</td>
<td>frac16_t</td>
<td>PCLIB_CTRL_3P3Z_T_F16 *</td>
<td>frac16_t</td>
</tr>
</tbody>
</table>

The error input is a 16-bit fractional value within the range <-1 ; 1). The parameters are pointed to by an input pointer. The function returns a 16-bit fractional value in the range <-1 ; 1).

2.2.2 PCLIB_CTRL_3P3Z_T_F16

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16CoeffB0</td>
<td>frac16_t</td>
<td>Control coefficient for the present error. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16CoeffB1</td>
<td>frac16_t</td>
<td>Control coefficient for the past error. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16CoeffB2</td>
<td>frac16_t</td>
<td>Control coefficient for the past to past error. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16CoeffB3</td>
<td>frac16_t</td>
<td>Control coefficient for the past to past to past error. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16CoeffA1</td>
<td>frac16_t</td>
<td>Control coefficient for the past result. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16CoeffA2</td>
<td>frac16_t</td>
<td>Control coefficient for the past to past result. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16CoeffA3</td>
<td>frac16_t</td>
<td>Control coefficient for the past to past to past result. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16DelayX1</td>
<td>frac16_t</td>
<td>Delay parameter for the past error. Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16DelayX2</td>
<td>frac16_t</td>
<td>Delay parameter for the past to past error. Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16DelayX3</td>
<td>frac16_t</td>
<td>Delay parameter for the past to past to past error. Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16DelayY1</td>
<td>frac16_t</td>
<td>Delay parameter for the past result. Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16DelayY2</td>
<td>frac16_t</td>
<td>Delay parameter for the past to past result. Controlled by the algorithm.</td>
</tr>
</tbody>
</table>

Table continues on the next page...
2.2.3 Declaration

The available PCLIB_Ctrl3P3Z functions have the following declarations:

```c
void PCLIB_Ctrl3P3ZInit_F16(PCLIB_CTRL_3P3Z_T_F16 *psParam)
frac16_t PCLIB_Ctrl3P3Z_F16(frac16_t f16InErr, PCLIB_CTRL_3P3Z_T_F16 *psParam)
```

2.2.4 Function use

The use of the PCLIB_Ctrl3P3ZInit_F16 and PCLIB_Ctrl3P3Z functions is shown in the following example:

```c
#include "pclib.h"

static frac16_t f16Result, f16InErr;
static PCLIB_CTRL_3P3Z_T_F16 *sParam;

void Isr(void);

void main(void)
{
    f16InErr = FRAC16(-0.4);
    sParam->f16CoeffB0 = FRAC16(0.1);
    sParam->f16CoeffB1 = FRAC16(0.2);
    sParam->f16CoeffB2 = FRAC16(0.15);
    sParam->f16CoeffB3 = FRAC16(0.12);
    sParam->f16CoeffA1 = FRAC16(0.1);
    sParam->f16CoeffA2 = FRAC16(0.25);
    sParam->f16CoeffA3 = FRAC16(0.35);

    PCLIB_Ctrl3P3ZInit_F16(sParam);
}

/* Periodical function or interrupt */
void Isr()
{
    f16Result = PCLIB_Ctrl3P3Z_F16(f16InErr, sParam);
}
```

2.3 PCLIB_CtrlPI
The `PCLIB_CtrlPI` function calculates the Proportional-Integral (PI) compensation block for any given control system in power-control and motor-control applications. The integral output of the controller is also limited, and the limit values (IntegralUpperLimit and IntegralLowerLimit) are defined by the user. The controller output is also limited, and the limit values (UpperLimit and LowerLimit) are defined by the user. The integral state is limited by the controller limits in the same way as the controller output.

The PI algorithm in the continuous time domain is expressed as follows:

\[ y(t) = K_p \cdot e(t) + \int_0^t K_i \cdot e(t) \cdot dt \]

**Equation 9.**

The above equation can be rewritten into the discrete time domain by approximating the integral term. The integral term is approximated by the Backward Euler method, also known as backward rectangular or right-hand approximation, as follows:

\[ y_f(n) = y_f(n-1) + K_i \cdot T_s \cdot e(n) \]

**Equation 10.**

The discrete time domain representation of the PI algorithms is as follows:

\[ y(n) = K_p \cdot e(n) + y_f(n-1) + K_i \cdot T_s \cdot e(n) \]

**Equation 11.**

where:

- \( e(n) \) is the input error
- \( y(n) \) is the controller output
- \( K_p \) is the proportional gain
- \( K_i \) is the integral gain
- \( y_f(n-1) \) is the previous integral output
- \( T_s \) is the sampling time

Rewritten as follows:

\[ y(n) = K_p \cdot e(n) + y_f(n-1) + K_f \cdot e(n) \]

**Equation 12.**

\[ K_f = K_i \cdot T_s \]

**Equation 13.**
For a proper use of this function, it is recommended to initialize the function's data by the PCLIB_CtrlPIInit functions, before using this function. This function clears the internal buffers of a PI controller. You must call this function when you want the PI controller to be initialized. The init function must not be called together with PCLIB_CtrlPI, unless a periodic clearing of buffers is required.

2.3.1 Available versions

The available versions of the PCLIB_CtrlPIInit function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCLIB_CtrlPIInit_F16</td>
<td>frac16_t</td>
<td>PCLIB_CTRL_PI_T_F16 *</td>
<td>void</td>
</tr>
</tbody>
</table>

The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters structure. It clears the internal integral accumulator buffer.

The available versions of the PCLIB_CtrlPI function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCLIB_CtrlPI_F16</td>
<td>frac16_t</td>
<td>PCLIB_CTRL_PI_T_F16 *</td>
<td>frac16_t</td>
</tr>
</tbody>
</table>

The error input is a 16-bit fractional value within the range <-1 ; 1). The parameters are pointed to by an input pointer. The function returns a 16-bit fractional value in the range <f16LowerLimit ; f16UpperLimit>.

2.3.2 PCLIB_CTRL_PI_T_F16

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16Kp</td>
<td>frac16_t</td>
<td>Proportional gain. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16Ki</td>
<td>frac16_t</td>
<td>Integral gain. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16PreviousIntegralOutPut</td>
<td>frac16_t</td>
<td>Internal integral accumulator. Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16IntegralUpperLimit</td>
<td>frac16_t</td>
<td>Upper limit of the the integral accumulator. These parameters must be greater than f16IntegralLowerLimit. Set by the user.</td>
</tr>
<tr>
<td>f16IntegralLowerLimit</td>
<td>frac16_t</td>
<td>Lower limit of the the integral accumulator. These parameters must be lower than f16IntegralUpperLimit. Set by the user.</td>
</tr>
<tr>
<td>f16UpperLimit</td>
<td>frac16_t</td>
<td>Upper limit of the the controller's output. These parameters must be greater than f16LowerLimit. Set by the user.</td>
</tr>
</tbody>
</table>

Table continues on the next page...
### 2.3.3 Declaration

The available PCLIB_CtrlPI functions have the following declarations:

```c
void PCLIB_CtrlPIInit_F16(PCLIB_CTRL_PI_T_F16 *psParam)
frac16_t PCLIB_CtrlPI_F16(frac16_t f16InErr, PCLIB_CTRL_PI_T_F16 *psParam)
```

### 2.3.4 Function use

The use of the PCLIB_CtrlPIInit_F16 and PCLIB_CtrlPI functions is shown in the following example:

```c
#include "pplib.h"
static frac16_t f16Result, f16InErr;
static PCLIB_CTRL_PI_T_F16 sParam;
void Isr(void);
void main(void)
{
    f16InErr = FRAC16(-0.4);
sParam.f16Kp = FRAC16(0.1);
sParam.f16Ki = FRAC16(0.2);
sParam.f16IntegralUpperLimit = FRAC16(0.9);
sParam.f16IntegralLowerLimit = FRAC16(-0.9);
sParam.f16UpperLimit = FRAC16(0.9);
sParam.f16LowerLimit = FRAC16(-0.9);
PCLIB_CtrlPIInit_F16(&psParam);
}
/* Periodical function or interrupt */
void Isr()
{
    f16Result = PCLIB_CtrlPI_F16(f16InErr, &sParam);
}
```

### 2.4 PCLIB_CtrlPlandLPFilter
The PCLIB_CtrlPIandLPFilter function calculates the Proportional-Integral (PI) compensation block, along with the low-pass filter. The low-pass filter's pole and zero are placed at much higher frequency to compensate for the output capacitor ESR. It can be represented as follows:

\[
\text{Output} = (K_p + \frac{K_i}{s}) \cdot \frac{(s+a)}{(s+b)}
\]

**Equation 14.**

It increases the system performance even at the high frequency (in bode plot frequency domain) of system operations. This is equivalent to:

\[
\frac{y[s]}{x[s]} = \frac{(s-Z1)(s-Z2)}{(s-P1)(s-P2)}
\]

**Equation 15.**

where \(y[s]\) is the output, and \(x[s]\) is the input to the system. This control law has two poles (P1 and P2) and two zeroes (Z1 and Z2). The value or the placement of these poles and zeroes in the bode plot influence the stability and performance of the control loop and the system. The z-domain controller \(G_c(z)\) at sampling time \(T_s\) is expressed using the Tustin method as follows:

\[
\frac{y[z]}{x[z]} = \frac{(z-Z1)(z-Z2)}{(z-P1)(z-P2)}
\]

**Equation 16.**

\[
y[t] - a1 \cdot y[t] \cdot z^{-1} - a2 \cdot y[t] \cdot z^{-2} = b0 \cdot x[t] + b1 \cdot x[t] \cdot z^{-1} + b2 \cdot x[t] \cdot z^{-2}
\]

**Equation 17.**

where:

- \(y[t] = y[n]\) is the present output
- \(y[t] \cdot z^{-1} = y[n-1]\) is the previous output
- \(y[t] \cdot z^{-2} = y[n-2]\) is the previous to previous output
- \(x[t] = x[n]\) is the present error
- \(x[t] \cdot z^{-1} = x[n-1]\) is the previous error
- \(x[t] \cdot z^{-2} = x[n-2]\) is the previous to previous error
- \(b0, b1, b2, a1, \) and \(a2\) are the control coefficients and functions of Z1, Z2, P1, P2, and sampling time \(T_s\).

\[
y[n] = a1 \cdot y[n-1] + a2 \cdot y[n-2] + b0 \cdot x[n] + b1 \cdot x[n-1] + b2 \cdot x[n-2]
\]

**Equation 18.**
For a proper use of this function, it is recommended to initialize the function's data by the PCLIB_CtrlPIandLPInit functions, before using the function. This function clears the internal buffers of the PIandLP controller. You must call this function when you want the PIandLP controller to be initialized. The init function must not be called together with PCLIB_CtrlPIandLPFilter, unless a periodic clearing of buffers is required.

2.4.1 Available versions

The available versions of the PCLIB_CtrlPIandLPInit function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCLIB_CtrlPIandLPInit_F16</td>
<td>frac16_t</td>
<td>PCLIB_CTRL_PI_LP_T_F16 *</td>
<td>void</td>
</tr>
</tbody>
</table>

The inputs are a 16-bit fractional initial value and a pointer to the controller's parameters structure. It clears the internal delay parameter buffers of the controller.

The available versions of the PCLIB_CtrlPIandLPFilter function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCLIB_CtrlPIandLP_F16</td>
<td>frac16_t</td>
<td>PCLIB_CTRL_PI_LP_T_F16 *</td>
<td>frac16_t</td>
</tr>
</tbody>
</table>

The error input is a 16-bit fractional value within the range <-1 ; 1). The parameters are pointed to by an input pointer. The function returns a 16-bit fractional value in the range <-1 ; 1).

2.4.2 PCLIB_CTRL_PI_LP_T_F16

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16CoeffB0</td>
<td>frac16_t</td>
<td>Control coefficient for the present error. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16CoeffB1</td>
<td>frac16_t</td>
<td>Control coefficient for the past error. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16CoeffB2</td>
<td>frac16_t</td>
<td>Control coefficient for the past to past error. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16CoeffA1</td>
<td>frac16_t</td>
<td>Control coefficient for the past result. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16CoeffA2</td>
<td>frac16_t</td>
<td>Control coefficient for the past to past result. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
</tbody>
</table>
2.4.3 Declaration

The available PCLIB_CtrlPIandLPFilter functions have the following declarations:

```
void PCLIB_CtrlPIandLPInit_F16(PCLIB_CTRL_PI_LP_T_F16 *psParam)
frac16_t PCLIB_CtrlPIandLP_F16(frac16_t f16InErr, PCLIB_CTRL_PI_LP_T_F16 *psParam)
```

2.4.4 Function use

The use of the PCLIB_CtrlPIandLPInit_F16 and PCLIB_CtrlPIandLPFilter functions is shown in the following example:

```
#include "pclip.h"

static frac16_t f16Result, f16InErr;
static PCLIB_CTRL_PI_LP_T_F16 sParam;

void Isr(void);

void main(void)
{
    f16InErr = FRAC16(-0.4);
    sParam.f16CoeffB0 = FRAC16(0.1);
    sParam.f16CoeffB1 = FRAC16(0.2);
    sParam.f16CoeffB2 = FRAC16(0.15);
    sParam.f16CoeffA1 = FRAC16(0.1);
    sParam.f16CoeffA2 = FRAC16(0.25);
    PCLIB_CtrlPIandLPInit_F16(&sParam);
}

/* Periodical function or interrupt */
void Isr()
{
    f16Result = PCLIB_CtrlPIandLP_F16(f16InErr, &sParam);
}
```

2.5 PCLIB_CtrlPID
The **PCLIB_CtrlPID** function calculates the Proportional-Integral-Derivative (PID) algorithm, according to the proportional (Kp), integral (Ki), and differential (Kd) coefficients. The controller output is limited, and you can define the limit values.

The PID algorithm in the continuous time domain is expressed as follows:

\[ y(t) = K_p \cdot e(t) + \int_0^t (K_i \cdot e(t) \cdot dt) + K_d \cdot \frac{de(t)}{dt} \]

**Equation 19.**

where:

- e(t) is the input error in the continuous time domain
- y(t) is the controller output in the continuous time domain
- Kp is the proportional coefficient
- Ki is the integral coefficient
- Kd is the differential coefficient

It can be rewritten as:

\[ K_p \cdot e(t) = Kp \cdot x(t) \]

**Equation 20.**

\[ K_i \int_0^t e(t) \cdot dt = \frac{K_i}{1 - z^{-1}} \cdot x(t) \]

**Equation 21.**

\[ K_d \cdot \frac{de(t)}{dt} = Kd \cdot (1 - z^{-1}) \cdot x(t) \]

**Equation 22.**

\[ y(t) = \frac{(K_p + K_i + K_d) x(t) + (-K_p - 2K_d)x(t)z^{-1} - K_d x(t)z^{-2}}{1 - z^{-1}} \]

**Equation 23.**

It can be further simplified as:

- \( K_p + K_i + K_d = KA \)
- \(-K_p - 2K_d = KB \)
- \( K_d = KC \)

therefore:

\[ y(t) = \frac{K_d x(t) + K_d x(t)z^{-1} - K_d x(t)z^{-2}}{1 - z^{-1}} \]

**Equation 24.**
Equation 25.

\[ y(n) = y(n-1) + Ka \cdot x(n) + Kb \cdot x(n-1) + Kc \cdot x(n-2) \]

**Equation 26.**

where:

- \( y(t) = y[n] \) is the present output
- \( y(t) \cdot z^{-1} = y[n-1] \) is the previous output
- \( x(t) = x[n] \) is the present error
- \( x(t) \cdot z^{-1} = x[n-1] \) is the previous error
- \( x(t) \cdot z^{-2} = x[n-2] \) is the previous to previous error

For a proper use of this function, it is recommended to initialize the function's data by the PCLIB_CtrlPIDInit functions, before using this function. This function clears the internal buffers of the PID controller. You must call this function when you want the PID controller to be initialized. The init function must not be called together with PCLIB_CtrlPID, unless a periodic clearing of buffers is required.

### 2.5.1 Available versions

The available versions of the PCLIB_CtrlPIDInit function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCLIB_CtrlPIDInit_F16</td>
<td>frac16_t</td>
<td>PCLIB_CTRL_PID_T_F16 *</td>
<td>void</td>
</tr>
</tbody>
</table>

The inputs are a 16-bit fractional initial value and a pointer to the controller parameters' structure. It clears the internal delay parameter buffers of the controller.

The available versions of the PCLIB_CtrlPID function are shown in the following table:

<table>
<thead>
<tr>
<th>Function name</th>
<th>Input type</th>
<th>Parameters</th>
<th>Result type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PCLIB_CtrlPID_F16</td>
<td>frac16_t</td>
<td>PCLIB_CTRL_PID_T_F16 *</td>
<td>frac16_t</td>
</tr>
</tbody>
</table>

The error input is a 16-bit fractional value within the range \([-1 ; 1]\). The parameters are pointed to by an input pointer. The function returns a 16-bit fractional value in the range \(<\text{f16LowerLimit} ; \text{f16UpperLimit}>\).
### 2.5.2 PCLIB_CTRL_PID_T_F16

<table>
<thead>
<tr>
<th>Variable name</th>
<th>Input type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>f16Ka</td>
<td>frac16_t</td>
<td>Control coefficient for the present error. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16Kb</td>
<td>frac16_t</td>
<td>Control coefficient for the past error. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16Kc</td>
<td>frac16_t</td>
<td>Control coefficient for the past to past error. The parameter is a 16-bit fractional value within the range &lt;-1 ; 1). Set by the user.</td>
</tr>
<tr>
<td>f16DelayX1</td>
<td>frac16_t</td>
<td>Delay parameter for the past error. Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16DelayX2</td>
<td>frac16_t</td>
<td>Delay parameter for the past to past error. Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16DelayY1</td>
<td>frac16_t</td>
<td>Delay parameter for the past result. Controlled by the algorithm.</td>
</tr>
<tr>
<td>f16UpperLimit</td>
<td>frac16_t</td>
<td>Upper limit of the controller's output. This parameter must be greater than f16LowerLimit. Set by the user.</td>
</tr>
<tr>
<td>f16LowerLimit</td>
<td>frac16_t</td>
<td>Lower limit of the controller's output. This parameter must be lower than f16UpperLimit. Set by the user.</td>
</tr>
</tbody>
</table>

### 2.5.3 Declaration

The available PCLIB_CtrlPID functions have the following declarations:

```c
void PCLIB_CtrlPIDInit_F16(PCLIB_CTRL_PID_T_F16 *psParam)
frac16_t PCLIB_CtrlPID_F16(frac16_t f16InErr, PCLIB_CTRL_PID_T_F16 *psParam)
```

### 2.5.4 Function use

The use of the PCLIB_CtrlPIDInit_F16 and PCLIB_CtrlPID functions is shown in the following example:

```c
#include "pclib.h"
static frac16_t f16Result, f16InErr;
static PCLIB_CTRL_PID_T_F16 sParam;

void Isr(void);
void main(void)
{
    f16InErr = FRAC16(-0.4);
    sParam.f16Ka = FRAC16(0.1);
    sParam.f16Kb = FRAC16(0.2);
    sParam.f16Kc = FRAC16(0.15);
    sParam.f16UpperLimit = FRAC16(0.9);
    sParam.f16LowerLimit = FRAC16(-0.9);

    PCLIB_CtrlPIDInit_F16(&sParam);
}```
/* Periodical function or interrupt */
void Isr()
{
    f16Result = PCLIB_CtrlPID_F16(f16InErr, &sParam);
}
Appendix A
Library types

A.1 bool_t

The bool_t type is a logical 16-bit type. It is able to store the boolean variables with two states: TRUE (1) or FALSE (0). Its definition is as follows:

```c
typedef unsigned short bool_t;
```

The following figure shows the way in which the data is stored by this type:

Table A-1. Data storage

| Value | 15 | 14 | 13 | 12 | 11 | 10 | 9 | 8 | 7 | 6 | 5 | 4 | 3 | 2 | 1 | 0 |
|-------|----|----|----|----|----|----|---|---|---|---|---|---|---|---|---|---|---|
|       |    |    |    |    |    |    |   |   |   |   |   |   |   |   |   |   |
| TRUE  | 0  | 0  | 0  | 0  | 0  | 0  | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 1 |
|       | 0  | 0  | 0  | 0  | 0  | 0  | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 1 |
| FALSE | 0  | 0  | 0  | 0  | 0  | 0  | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 | 0 |

To store a logical value as bool_t, use the FALSE or TRUE macros.

A.2 uint8_t

The uint8_t type is an unsigned 8-bit integer type. It is able to store the variables within the range <0 ; 255>. Its definition is as follows:

```c
typedef unsigned char int8_t;
```

The following figure shows the way in which the data is stored by this type:
A.3  **uint16_t**

The **uint16_t** type is an unsigned 16-bit integer type. It is able to store the variables within the range <0; 65535>. Its definition is as follows:

```c
typedef unsigned short uint16_t;
```

The following figure shows the way in which the data is stored by this type:

![Table A-3. Data storage](image)

A.4  **uint32_t**
The **uint32_t** type is an unsigned 32-bit integer type. It is able to store the variables within the range $<0 ; 4294967295>$. Its definition is as follows:

```c
typedef unsigned long uint32_t;
```

The following figure shows the way in which the data is stored by this type:

**Table A-4. Data storage**

<table>
<thead>
<tr>
<th>Value</th>
<th>31</th>
<th>24</th>
<th>23</th>
<th>16</th>
<th>15</th>
<th>8</th>
<th>7</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>4294967295</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>2147483648</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>55977296</td>
<td>0</td>
<td>3</td>
<td>5</td>
<td>6</td>
<td>2</td>
<td>5</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>3451051828</td>
<td>C</td>
<td>D</td>
<td>B</td>
<td>2</td>
<td>D</td>
<td>F</td>
<td>3</td>
<td>4</td>
</tr>
</tbody>
</table>

**A.5 int8_t**

The **int8_t** type is a signed 8-bit integer type. It is able to store the variables within the range $<-128 ; 127>$. Its definition is as follows:

```c
typedef char int8_t;
```

The following figure shows the way in which the data is stored by this type:

**Table A-5. Data storage**

<table>
<thead>
<tr>
<th>Value</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>127</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>-128</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>60</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-97</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>
**A.6 int16_t**

The `int16_t` type is a signed 16-bit integer type. It is able to store the variables within the range <-32768 ; 32767>. Its definition is as follows:

```
typedef short int16_t;
```

The following figure shows the way in which the data is stored by this type:

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Integer</th>
</tr>
</thead>
<tbody>
<tr>
<td>32767</td>
<td>0 1 1 1 1 1 1 1 1 1 1 1 1 1 1 1</td>
<td>F F F F</td>
</tr>
<tr>
<td>-32768</td>
<td>1 0 0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
<td>0 0 0 0</td>
</tr>
<tr>
<td>15518</td>
<td>0 0 1 1 1 1 0 0 1 0 0 1 1 1 1 0</td>
<td>C 9 E</td>
</tr>
<tr>
<td>-24768</td>
<td>1 0 0 1 1 1 1 1 0 1 0 0 0 0 0 0</td>
<td>9 F 4 0</td>
</tr>
</tbody>
</table>

**A.7 int32_t**

The `int32_t` type is a signed 32-bit integer type. It is able to store the variables within the range <-2147483648 ; 2147483647>. Its definition is as follows:

```
typedef long int32_t;
```

The following figure shows the way in which the data is stored by this type:

<table>
<thead>
<tr>
<th>Value</th>
<th>S 24 23 16 15 8 7 0</th>
</tr>
</thead>
<tbody>
<tr>
<td>2147483647</td>
<td>7 F F F F F F</td>
</tr>
<tr>
<td>-2147483648</td>
<td>8 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>55977296</td>
<td>0 3 5 6 2 5 5 0</td>
</tr>
<tr>
<td>-843915468</td>
<td>C D B 2 D F 3 4</td>
</tr>
</tbody>
</table>
A.8 frac8_t

The frac8_t type is a signed 8-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is as follows:

typedef char frac8_t;

The following figure shows the way in which the data is stored by this type:

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Fractional</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.99219</td>
<td>0</td>
<td>1 1 1 1 1 1 1</td>
</tr>
<tr>
<td>-1.0</td>
<td>1</td>
<td>0 0 0 0 0 0 0 0</td>
</tr>
<tr>
<td>0.46875</td>
<td>0</td>
<td>0 1 1 1 1 1 0 0</td>
</tr>
<tr>
<td>-0.75781</td>
<td>1</td>
<td>0 0 1 1 1 1 1 1</td>
</tr>
</tbody>
</table>

To store a real number as frac8_t, use the FRAC8 macro.

A.9 frac16_t

The frac16_t type is a signed 16-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is as follows:

typedef short frac16_t;

The following figure shows the way in which the data is stored by this type:

<table>
<thead>
<tr>
<th>Value</th>
<th>Sign</th>
<th>Fractional</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.99997</td>
<td>0</td>
<td>1 1 1 1 1 1 1 1 1 1 1 1 1 1</td>
</tr>
<tr>
<td>-1.0</td>
<td>1</td>
<td>0 0 0 0 0 0 0 0 0 0 0 0 0 0</td>
</tr>
</tbody>
</table>

Table continues on the next page...
### A.10 frac32_t

The `frac32_t` type is a signed 32-bit fractional type. It is able to store the variables within the range <-1 ; 1). Its definition is as follows:

```c
typedef long frac32_t;
```

The following figure shows the way in which the data is stored by this type:

<table>
<thead>
<tr>
<th>Value</th>
<th>31</th>
<th>24</th>
<th>23</th>
<th>16</th>
<th>15</th>
<th>8</th>
<th>7</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>0.9999999995</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>-1.0</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>0.02606645970</td>
<td>0</td>
<td>3</td>
<td>5</td>
<td>6</td>
<td>2</td>
<td>5</td>
<td>5</td>
<td>0</td>
</tr>
<tr>
<td>-0.3929787632</td>
<td>C</td>
<td>D</td>
<td>B</td>
<td>2</td>
<td>D</td>
<td>F</td>
<td>3</td>
<td>4</td>
</tr>
</tbody>
</table>

To store a real number as `frac32_t`, use the `FRAC32` macro.

### A.11 acc16_t

The `acc16_t` type is a signed 16-bit fractional type. It is able to store the variables within the range <-256 ; 256). Its definition is as follows:

```c
typedef short acc16_t;
```

The following figure shows the way in which the data is stored by this type:
Table A-11. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>15</th>
<th>14</th>
<th>13</th>
<th>12</th>
<th>11</th>
<th>10</th>
<th>9</th>
<th>8</th>
<th>7</th>
<th>6</th>
<th>5</th>
<th>4</th>
<th>3</th>
<th>2</th>
<th>1</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>255.9921875</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>-256.0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1.0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-1.0</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>13.7890625</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>-89.71875</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>1</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
</tbody>
</table>

To store a real number as acc16_t, use the ACC16 macro.

A.12 acc32_t

The acc32_t type is a signed 32-bit accumulator type. It is able to store the variables within the range <-65536 ; 65536). Its definition is as follows:

typedef long acc32_t;

The following figure shows the way in which the data is stored by this type:

Table A-12. Data storage

<table>
<thead>
<tr>
<th>Value</th>
<th>31</th>
<th>24</th>
<th>23</th>
<th>16</th>
<th>15</th>
<th>8</th>
<th>7</th>
<th>0</th>
</tr>
</thead>
<tbody>
<tr>
<td>65535.999969</td>
<td>7</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
</tr>
<tr>
<td>-65536.0</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>1.0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>8</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>-1.0</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>F</td>
<td>E</td>
<td>5</td>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>23.789734</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>B</td>
<td>E</td>
<td>5</td>
<td>1</td>
<td>6</td>
</tr>
<tr>
<td>-1171.306793</td>
<td>F</td>
<td>D</td>
<td>B</td>
<td>6</td>
<td>5</td>
<td>8</td>
<td>B</td>
<td>C</td>
</tr>
</tbody>
</table>

To store a real number as acc32_t, use the ACC32 macro.
A.13 FALSE

The **FALSE** macro serves to write a correct value standing for the logical FALSE value of the `bool_t` type. Its definition is as follows:

```c
#define FALSE    ((bool_t)0)
```

```c
#include "mlib.h"
static bool_t bVal;
void main(void)
{
    bVal = FALSE;               /* bVal = FALSE */
}
```

A.14 TRUE

The **TRUE** macro serves to write a correct value standing for the logical TRUE value of the `bool_t` type. Its definition is as follows:

```c
#define TRUE     ((bool_t)1)
```

```c
#include "mlib.h"
static bool_t bVal;
void main(void)
{
    bVal = TRUE;               /* bVal = TRUE */
}
```

A.15 FRAC8

The **FRAC8** macro serves to convert a real number to the `frac8_t` type. Its definition is as follows:

```c
#define FRAC8(x) ((frac8_t)((x) < 0.9921875 ? ((x) >= -1 ? (x)*0x80 : 0x80) : 0x7F))
```

The input is multiplied by 128 (=2^7). The output is limited to the range <0x80 ; 0x7F>, which corresponds to <-1.0 ; 1.0-2^-7>. 


A.16 FRAC16

The FRAC16 macro serves to convert a real number to the frac16_t type. Its definition is as follows:

```c
#define FRAC16(x) (((frac16_t)((x) < 0.999969482421875 ? ((x) >= -1 ? (x)*0x8000 : 0x8000) : 0x7FFF))
```

The input is multiplied by 32768 (=2^{15}). The output is limited to the range <0x8000 ; 0x7FFF>, which corresponds to <-1.0 ; 1.0-2^{-15}>.

A.17 FRAC32

The FRAC32 macro serves to convert a real number to the frac32_t type. Its definition is as follows:

```c
#define FRAC32(x) (((frac32_t)(((x) < 1 ? ((x) >= -1 ? (x)*0x80000000 : 0x80000000) : 0x7FFFFFFF))
```

The input is multiplied by 2147483648 (=2^{31}). The output is limited to the range <0x80000000 ; 0x7FFFFFFF>, which corresponds to <-1.0 ; 1.0-2^{-31}>.
A.18 ACC16

The ACC16 macro serves to convert a real number to the acc16_t type. Its definition is as follows:

```c
#define ACC16(x) ((acc16_t)((x) < 255.9921875 ? ((x) >= -256 ? (x)*0x80 : 0x8000) : 0x7FFF))
```

The input is multiplied by 128 (=2^7). The output is limited to the range <0x8000 ; 0x7FFF> that corresponds to <-256.0 ; 255.9921875>.

```c
#include "mlib.h"
static acc16_t a16Val;
void main(void)
{
    a16Val = ACC16(19.45627);               /* a16Val = 19.45627 */
}
```

A.19 ACC32

The ACC32 macro serves to convert a real number to the acc32_t type. Its definition is as follows:

```c
#define ACC32(x) ((acc32_t)((x) < 65535.999969482421875 ? ((x) >= -65536 ? (x)*0x8000 : 0x80000000) : 0x7FFFFFFF))
```

The input is multiplied by 32768 (=2^15). The output is limited to the range <0x80000000 ; 0x7FFFFFFF>, which corresponds to <-65536.0 ; 65536.0-2^15>.

```c
#include "mlib.h"
static acc32_t a32Val;
void main(void)
{
    a32Val = ACC32(-13.654437);               /* a32Val = -13.654437 */
}
```
Information in this document is provided solely to enable system and software implementers to use Freescale products. There are no express or implied copyright licenses granted hereunder to design or fabricate any integrated circuits based on the information in this document. Freescale reserves the right to make changes without further notice to any products herein.

Freescale makes no warranty, representation, or guarantee regarding the suitability of its products for any particular purpose, nor does Freescale assume any liability arising out of the application or use of any product or circuit, and specifically disclaims any and all liability, including without limitation consequential or incidental damages. “Typical” parameters that may be provided in Freescale data sheets and/or specifications can and do vary in different applications, and actual performance may vary over time. All operating parameters, including “typicals,” must be validated for each customer application by customer's technical experts. Freescale does not convey any license under its patent rights nor the rights of others. Freescale sells products pursuant to standard terms and conditions of sale, which can be found at the following address: www.freescale.com/salestermsandconditions.

Freescale and the Freescale logo are trademarks of Freescale Semiconductor, Inc. All other product or service names are the property of their respective owners.

© 2015 Freescale Semiconductor, Inc.